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Preface

Remote Sensing and GIS has found diverse applications in forestry. For monitoring
and assessment of forest resources, use of Remote Sensing and GIS has now become
inevitable. With the implementation of National Working Plan Code 2014, there is
extensive use of GIS in preparation of working plans. In this scenario, it is need of the
hour to develop capacity of the State Forest Departments in using GIS software
which are easily available to the users and are easy to operate.

Quantum GIS (QGIS) is one such software which is a freely downloadable and open source software of
GIS applications. QGIS provides excellent capabilities, stable operation and support numerous vector,
raster, database, formats and functionalities. Like other GIS applications, QGIS provides a
geographical user interface wherein different layers of spatial data can be displayed and analysed.
Many commercial GIS software available in the market are very expensive and cost a huge financial
burden onusers not only in purchasing licenses but also for their annual maintenance.

Considering numerous uses of GIS in different forestry applications and heavy cost of proprietary
software, FSI has included modules on QGIS in its training programmes to develop capacity of the
State Forest Departments (SFD) in use of QGIS.

The Manual of Quantum GIS for Basic Forestry Applications Version 1.0, developed by FSl is a step in
popularising QGIS in the SFDs. The manual contains different chapters describing the basic concepts
of QGIS and easy to understand steps illustrated through screen shots of GUIs. The manual will enable
users to understand and perform basic GIS analysis such as geo-referencing, creating geo-spatial
layers, vector processing, map composition etc.

| acknowledge the sincere efforts done by Dr. Madhu Bist, Project Scientist in preparing this manual.
She has developed deep understanding of different functionalities of QGIS software. Contributions of
Shri Sushant Sharma JD (TFID) and Shri Prakash Lakhchaura DDG are acknowledged. Thanks are also
due to other officers and staff of FSI who have contributed in preparation of the manual. | hope, the
manual will be immensely useful to the SFDs. FSlisin the process of developing an advanced manual
on QGIS also for different forestry applications and the same will be shortly made available to the

users.

23 May, 2019 (Dr. Subhash Ashutosh)
Director General, FSI
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CHAPTER 1:

QUANTUM GIS
Be—

QGIS is an Open Source Geographic Information System. QGIS was first developed and established as
a project Source Forge in 2002. QGIS known as Quantum GIS is a cross-platform, free and open source
Geographic Information system (GIS) application that provides capability of data viewing, editing and
analysis of spatial data. QGIS allow users to create maps with many layers using different map
projections. It currently runs on multiple operating systems, most Unix platforms, Windows, and
macOS. QGIS is developed using the Qt toolkit (https:/www.qgt.io) and C++. Therefore, easy-to-use
graphical user interface (GUI). QGIS aims to be a user-friendly GIS, providing common functions and
features. The initial goal of the project was to provide a GIS data viewer.

QGIS supports a number of raster and vector data formats. QGIS supports vector, raster and database
formats. It supports many common spatial data formats (e.g. ESRI Shapefile, geotiff) with new format
support easily added using the plugin architecture.

QGIS is released under the GNU General Public License (GPL). Developing QGIS under this license
means that you can inspect, modify the source code and always have access to a GIS program that is
free of cost and can be freely modified.

What QGIS cando?

e View spatial data.

e Digitise points, lines and polygons.

e Import GPS datain GIS layer, view GPS data (point, line, polygon on Google earth).
e Georeference Satellite images including Google earth images.

e Measure area, perimeter, length.

e Compose mapsondesirable scale.

e Create buffer along the roads around the villages, forest etc.

Note: Installation of QGIS Software

e |[nsertthe Compactdisc (CD) where the Software is saved.

e Doubleclickon QGIS .exe setup file and click on next button.

e Readthe License Agreementand click on | Agree button.

e Choose the location (Local Drive) you want to install the software and click on next button then
click install.

e Please wait while installation and extraction process is in progress.

e Wheninstallationis completed, click on Finish button and open the software.
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1.1 QUANTUMGIS GRAPHICAL USER INTERFACE

When QGIS starts, you are presented with the GUl as shown in the figure:
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The QGIS GUl is divided into five areas:

1. Menu Bar: Provides access to various QGIS features using a standard hierarchical menu.

2. Tool Bar: Provides access to most of the functions as the menus, plus additional tools for
interacting with the map.

3.  Map Legend: Lists all the data layers in the project. This area also allows to change style or label
the layer.

4. Map View: The map displayed in this window will depend on the vector and raster layers you
have chosen to load.

5. Status Bar: The status bar shows you your current position in map coordinates as the mouse
pointer is moved across the map view.

e Using these five areas (as mentioned above), you can add a data layers, zoom to a specific area
in the data, hide or show relevant layers and see the coordinates, scale and projection of your
displayed map.

NOTE: You can use middle button of your mouse to pan the map.
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CHAPTER 2:

GEOREFERENCER PLUGIN

e  The Georeferencer Plugin is a tool | leen | Purpose leon | Purpose
for generating world files for rasters. '-J Open raster .; Start georeferencing
It allows you to reference rasters to . | Cenemie QOAL Jese "8 | Load GCP Points
geographic or prgjected coordlna.te :5 Save Gf?P Points As ;; Transformation seitings
systems by creating a new GeoTiff 2 Add Paint @ | Delete Poin
or by adding a world file to the 'H"_E Maove GCF Point {r:' Pan
existing image. The basic approach -’f Zoom [n #~ | Zoom Ou
to georeferencing a raster is to b | zoom To Layer #8 | Zoom Last
locate points on the raster for which 48 | Zoom Next O | Liok Georeterencer 1 QGIS
you can accurately determine F‘ﬂ Link QOIS 1o Georeferencer | Bl Full histogram stretch
coordinates. _ L Local histogram stretch

Table: Georeferencer Tools

° As X andY coordinates (DMS (dd mm ss.ss), DD (dd.dd) or projected coordinates (mmmm.mm)),
which correspond with the selected point on the image, two alternative procedures can be used:

(i) Enterthe GCP's (Ground Control Points) by specifying coordinates manually:
It involves selecting multiple points/ GCP's on the raster, specifying their coordinates, and

choosing a relevant transformation type. The more GCP's provides the better would be the
result.

(ii) Using already georeferenced layers:
The georeferenced layer can be either belong to vector or raster data that contain the same
objects/features that you have on the image to georeference. In this case, you can enter the
coordinates by clicking on the reference dataset loaded in the QGIS map canvas.

2.1 Entering ground control points (GCPs)

e  To start georeferencing an unreferenced raster, we must load it using the button. The raster
will show up in the main working area of the dialog. Once the raster is loaded, we can start to
enter reference points.

° Using the ;"" Add Point button, add points to the main working area and enter their coordinates
(see Figure). For this procedure there are three options:

Q-GIS MANUAL | Page 03




Clickonapointintherasterimage and enter the Xand Y coordinates manually.

b.  Click onapointin the rasterimage and choose the & from map canvas button to add the X

and Y coordinates with the help of a georeferenced map already loaded in the QGIS map
canvas.

c.  Withthe#g button, you can move the GCPs in both windows, if they are at the wrong place.

2.1a (i) Add GCPs

e Toadd GCPsgotoRaster >Georeferencer > Georeferencer.
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e  Then Georeferencer window will appear as viewing in the figure below.
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2.1a (ii) Defining the transformation settings

e  After you have added your GCPs to the raster image, you need to define the transformation
settings for the georeferencing process.

e  GotoSettings > Transformation Settings and set transformation parameters accordingly.
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2.1a (iii) Define the Resampling method

The type of resampling you choose will likely depending on your input data and the ultimate objective
of the exercise. If you don't want to change statistics of the image, you might want to choose 'Nearest
neighbour’, whereas a'Cubic resampling’ will likely provide a more smoothed result.

ERRA MR A28 PAARBAD 00 -H-5 LN EE =7 -
ReV:Ae r /BB se =4f{s54942 R 290
B K 3 Gaaraie = =
12T T | m s
e ‘ e 0 s D s v~ ki
ko I
4 &M 1 iy i . .
P——— T R | Change Transformation
b T Snsirame oe fires \ I type from Linear to
b soa st -
fl e T — —~_Polynomial
DR Tgei RS ESARE WG5 2 [k
b Pt
¥ s RESTE
b i Dl (M G ITRECTE D o a
& Ul m-l E.h. - ) ) 'l:
|: Dimnm e fiz s e sl
r:“’ Liw 0ty marmparey whan rescar
- - 'y il e
‘ 5
e K
fRRYR-BY
4 il AAn
Gana P CrHadw CETRECT =
W"'j! Garmin PO et ] [ ne_.
il | 2 i QES b e
# q|
¥ B
-
¥
o= L g
L il v e | TEwr i HT R Farw || eennen Gge I (¥ Rarder

Q-GIS MANUAL | Page 07




2.1a (iv) Running the transformation

After all GCPs have been collected and all transformation settings are defined, just press the [ Start
georeferencing button to create the new georeferenced raster.
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) _ Georeference Successfulk Raster was successfuly georeferenced. 6
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2.2 Assigning GCP’'s by using georeferenced layer

Georeferencing is the process of assigning real-world coordinates to each pixel of the raster. The
method involved reading the coordinates from reference (already defined map projection) or scanned
map and inputting it manually by identifying similar features in input and reference image as well.

e To enable the Georeferencer for the first time, go to plugin from Plugins > Manage and install
Plugins > Installed.

° Now, the pluginis installed in the Raster menu.
e Firstofall,openreferencedimage/base image (georeferenced toposheet) on map canvas.

e  GotoopenaGDAL supported Raster data source and browse for the georeferenced file.

Click here to open
georeferenced file
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e  Tostart georeferencing of input image (satellite imagery) by taking reference of already rectified
image (SOl toposheet), launch the Georeferencer from Raster.
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Click on Raster > Georeferencer > Georeferencer to open the plugin.
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Then georeferencer window will appear on map canvas as showing in Figure.
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In the Georeferencer window, go to File > Open raster > Navigate to the downloaded tif/jpg file

and click Open.

Input file will appear on georeferencer window as showing in figure.
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We can display a color composite of bands in the Working toolbar, click the list RGB > and select

the item 3-2-1(corresponding to the band numbers in Band set).

Go to layer properties/Style by going to settings > Raster properties > and put Band 3 in the Red

band, Band 2 in the Green Band and Band 1in the Blue band.
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° Now click on the Add Point button on the toolbar and select an easily identifiable location such as
junctions, corners, intersections, poles etc on the image to get good control points.
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Click here to add
control point

e  Once click on the image at a control point location, we will see a pop-up asking about to enter

map coordinates.
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° Click the button From map canvas.
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° Now, find the same location in your reference layer, i.e SOl toposheet in map canvas and place
GCP by clicking on similar identified feature.

e  Thecoordinates are automatically populated by clicking on the map canvas.
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e  Click Ok.

e  Similarly, choose at least 4 points on the image and add their coordinates from the reference
layer.
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Now go to Settings > Transformation settings > choose the settings as showing in Figure. Ensure
to check Load in QGIS when done button to open the georeferenced layer by its own after

running algorithm.
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Torunthe process, go to Georeferencer window > go to file > start georeferencing or directly click

to [ start georeferencing button. This will start
the process of warping the image using the GCPs
and creating the georeferenced raster.

Once the algorithm finishes, the georeferenced
layer loaded in map canvas of QGIS.

To validate the accuracy of georeferenced file,
load and overlay the referenced file on created
georeferenced file.

To remove the black and white, (black or white
pixels in the image are no-data values and
should be made transparent). Right click on the
image layer > choose Properties > Switch to the
Transparency tab.
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e  Specify Input O as the No data value in additional no data value. Now in the Custom transparency
options > click the + button > and add 255 as the transparent pixels for each band > and enter
100 as the Percent transparent > Click OK. Now it will remove the outer black area from the image.
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e  Toopen Transparency slider in layer panel again Right click on top layer > properties > legend >
select Transparency slider > select button b
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° Now the transparency slider will appear in Layer panel and accordingly by sliding we can set
transparency and validate the results, if georeferenced layer is overlapping properly on
base/referenced layer.

e InthegivenFigure, we will see that georeferenced image accurately overlaid on the base layer.
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NOTE: If in case the output is not satisfying, it can be further improved by taking more number of
control points.
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CHAPTER 3:

DOWNLOADING GPS
DATA IN QGIS

3.(a) Afterinstalling QGIS software (refer to the base at the bottom) in the computer, open QGIS
software.

3.(b) Inthe Menu Toolbar, click Vector menu > click on GPS>choose GPS tools.

2 QGIS 2.10.1-Pisa
Project Edit View Layer Settings  Plugins |‘I.Ectur Raster Datsbase Web Processing MMOGIS  Help

3.(c) When GPStoolis activated small box will appear in the Map Canvas
3.(d) Inthe GPStoolbox >click download from GPS option

/& GPS Tools 7 bt

| Load GPX file | Importother fle | Download from GPS | Upload to GPS | GPX Conversions |

GPS device | Garmin serial = | | Edit devices. .
Port | usb: \v|| Refresh

Feature type LWarpn'rﬂB i vJ

Layer name | |

Output fle | || savess... |

DKHCaneel||_Heb|

3.(e) IntheGPSdeviceselect >Garmin serial.
3.(f) Intheportoptionselectusb.

3.(9) Inthe features type option select waypoint, track, routes (choose any feature you want to
transfer).

3.(h) Inthelayer name >specify or type any name.
3.() Intheoutput file option > specify the drive and folder to save the output> click ok.

(After the transfer is done GPS data will automatically display in the map canvas of QGIS).
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CHAPTER 4:

CREATION OF NEW
SHAPEFILE IN QGIS

4.(a) Tocreateanew layer forediting choose new layer vector from Layer menu >
Click on new shapefile layer.

vector w /7 New Spatialite Layer... Ctrl+5hift+A

' o New Shapefile Layer... Ctrl +Shift -+
Eﬁ; % Mew Temporary Scratch Layer...

=

layer icon &

4.(b) Thenew vector layer dialog box will be displayed as shown in figure below.

4 Mew Vectar Layer 7 %
Select CRS as Type Select point, line
per choice, * Pont Line Potvon ————— or polygon as per
the requirement
GCS or PCS \m o
Selectd CRE (EPSG:4326, WEE 84) v|E|
New atbribute
Mz —_—
Type Tt data = Type a name
Width | B0 Precson | i
| allrioutes |
Attribites list
riame [Tn:le [wiith ii?'re-:-an
d Integer 10
[N | FaTel
= BITIC cieg e |
ok || Cancd Hal
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4.b (i) Choose any feature typei.e. point/line/polygon as the case may be.

() Point () Line (=) Polygon

4.b (ii) Select and specify the Coordinates Reference System (CRS).

Selected CRS (EPSG: 4326, WGS 849) - | e
Selected CRS (FPSG:4326, WGS 84)

4.b (iii) To complete the creation of New shapefile layer > go to New attribute field > specify any
name>type (choose text ,decimal,whole number ,date) > then click add to attribute list>

click OK.
Give specific
tiribute
pic k/ name to
Name [waypoint] ] shapefile as
Type. | Tentcain x per the
Width | B0 Precision | | choice
Add to atirbutes kst [

Attributes list Add sitrbude o st

(tame e [ [precson

o Integer 10

waypoint Stng Bl

4]

4.(c) Afterclicking ok option >save layer as dialog box will appear > then specify the Drive and

folder to save the output file>Give name to output file> click save.

¥ Savelayeras. x
+ e Local Disk [D:) » prac2 w | Search prac e
Organise = New folder =~ 8
#
& | Videos o MName Date modified Type
I This PC w L] Potygonshp 02-02-2017 1605 SHP File
I Desktop | ] waypoint.shp 03-02-2017 12247 SHP File
[ T ™ “ €l ul >

File name: | Palygor.shp
Save as type:  ESRI Shapefile [OGR] (*.shp *.SHP)

W

W

A Hide Fuldes | Swe ||
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CHAPTER 5:

DIGITIZING A NEW OR EDITING
AN EXISTING LAYER

5.(a) Allediting session start by choosing the toggle editing option
5.(b) Usetheadd featuresicononthetoolbartoadd new features (point, line or polygon).

L -
A Add Feature. ‘\,EJ Add Festure g % Add Feature

5.(c) Next start digitise the feature i.e. point, line or polygon, left-click on the map area to create the
first point of your new feature >then enter its attributes (same way with both line and polygon).

% waypoint - F... ? X
id |1 &
ad I.-".-'I'..-Ei

o) [
S

5.(d) Afterdigitizingclick onsave layer edits iE|
5.(e) To calculate area, length and perimeter > go to layer option > click on polygon features > right
click.

Layers

d = T & 7 L

"

i

X waypoint

N
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5.(f) Select Open Attribute Table.
[l Remove
L] Duplicate
Set Layer Scale Visibility
Set Layer CRS
Set Project CRS from Layer
Styles k
8 Cpen Attnbute Table
¢ Toggle Editing
Save As..
Save As Layer Definition File...
Filter...
Show Feature Count

5.(9) Onedialogbox willappear>thenclick ontoggling editing , mode to start Calculating area,
length or perimeter.

5.(h) Thenclick on expression [ﬂ (for calculating the length, perimeter and area).

5.(i) Expression dialog box will appear >in the function option >select geometry >click on $area,
$perimeter, $length (to calculate area/perimeter/length) > click ok> then click update all
option (the software will automatically calculate the Area/length/perimeter as shown in figure
below).

# Expression disleg 7 =

Expression | Function Bdior
Exprasgion Fursctons

o {1 [ 1| 1118 ) Search #area function

1 Dpual:nw : Redurns the ares s of
I Conditionals e currend feature
1 Fiehdts and Yalues
W1 Math Symiles
& Conversions

& Date and Time
E'h'lng Lrgurmenis
Coboy
Geometry Hone

Sqeametr -

g""’_ﬂ‘hd —| | saces - 42
perimetes

Sx

Ty

x_at

y_at

X_uin

K_Mmiax

¥_min

¥_max
geom_fram_.
geom_from_..
4 ] i intersects b %
<] ] Ak plois =1

Sace=a

nECED

Al e m s
= I8 =

= |K|
@
g 1
o
- 1
[ 14
]
o
i 5

J o w | awe [ weaseh | eoememm | acensam
i 0 3.33136580424 | 359691,0000000 | 790.573 14535300 3330366
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CHAPTER 6:

GEOREFERENCE A DOWNLOADED
GOOGLE EARTH IMAGE

6.(@) To georeference the Google earth image > Go to menu bar >select Raster>select
Georeference> open raster option > add the save Google earth image to Georeference >

specify the CRS.

Add point

Wi eoreterencer - wardd,pg

File Edit View Settings L

' ’\ = | ;E F. . 'L,.

L% 08P

Open /

raster \\
# Erter map c\rdina’t:‘s L x
Ender ¥ ar] f . I or projected ooondnates | mwomo med}
sbichi pernatively, dick the bitton waih of
= Start georeferencing tool [smer=y o i st v conofs
sont.
% [East 51525671 ¥ (Morth |25 34 %674 I

¥ snap o badoround yvers

(= 4 # From map camves Cancel

6.(b) After adding four points >go to setting>transformation setting> in the target SRS select
the coordinate reference system (CRS) > specify the output file> click Ok Run (start
georeferencing tool).

Tiaraforrazn Tqe Linewr -
Rsemroing method Fimwrar: neghbor -
T gt SRS e (R (EPSL N4, ¥ = B

Ol S
Ot racr
Coepreissn  Mane -

Cregie workd B poly e Dorefomes)
s 3 for Hrampurarcy when nesded

Serl g | remckn
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6.(c) Tocomposethe georeferenceimage you have to follow steps 11a-d (pg. 37).

e X A lem lm b
H BedE Bag g4 NEREQN O J o | "Iy
B, e I fi 1 R R P e e - T P R T T R T T |

f
e

o
]

-l
3
i

e warr e

NS ] NS 0 DS ROEn
- 1 1 1 ]

1=

5. T Y T P— e ]
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CHAPTER 7:

HOW TO OPEN SATELLITE IMAGE
[RASTER DATA] IN QGIS

7.a(i) Open QGISsoftware >goto addraster layericon 'a andclickintheicon.
7.a(ii) Immediately one dialog box will appear in the frame > then click on the specific image> click
opentoadd theimage in the map canvas or frame.

Progmct Edf Ve Loew Sefeym Pugre Vel Sawie Debbme Web Preemeg e
BBRSA HOPELIAPBPLLAABES 06 -K-8-5
¥ 4 & Open 3 GDAL Supgeeeted Panter Date Sounce X
- © A e ThaPC o MewVolumefEi « 055 o Rusee-ecner w O | Samech Nagtue vacs o
‘l‘; Crpasecs = Firs \edder e+« T 9
'; = Tha bt - -
Al Bwotem
‘ B Dekiop
o
i Documents [RLER gea_grided gL g ELan gua,giLihp gra_grivh
I{E & Oonrineh 2
. & Puares e
‘f; B e -—
e fe Lol Dk (D) »  RiieeVectondid  FasteeVechoops  MesterVectsnhg  BusterVectoihs - e -
;lﬂ Fibe marnes | | |0 s
v =
| Image will appear as showing in Figure
T - e ——— TF o =
BRCEG MerprrRipgahnre as h Wz =
agM.Am r AL - Fhe. . ne : \ £
v o=
GlleAnT -0
S
%
0
.u.-
@
&
-
\.f_

[ TR N ST
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7.a(iii) Goto layer > click in the image > right click > go to properties > go to style option to change the
band combination (for red band 3,green band 2 and blue band 1) >click apply then ok.

o Layer Properties - west garo_lissd | Style ? *
. Genera .' Mrm '.-:_
Render type  Muithand color jt
|-! Transparency fed band Band 3 = Load min/max values
ﬁ Pyramids Min/max L ] C"ma:ur:t 2-';.| : = ﬁ:ﬂ : f
R istogran hors; [Bal2 : 2 Min | ma
Minjma Mean +/- -
i Wetada 2"_“? A -
| Metadats Bueband | Bend 1 I standard deviation
Extent
P - Accuracy
® Ful ® Estimate (faster)
Contrast =
¢ | Mo enhancement Current Akl Gkoper)
Load e
i
2l _ Jd  (a]x]
Stje - | ok || cance Acrly Hep
| Image will appear as showingi&j
gt PR e L “ Fugre  wwEe s Ll ke = L
BRACRA Me 2R, Panlng 06 -5 -u-5,0 @ =-FT-

BEV./® 2/ BES-RErO0e ~als

" E-G- v Domn - RALDEERE L) oxonne  iwn ieme 5 EEE
f-'m"'_-o.r--ns.
LERLLE

4

RSEDSAENS NS
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CHAPTER 8:

CLIP

Clipping is the process by which a subset of the raster as well as vector dataset is created. Clipping
removes data outside the area of interest reducing the file size and improving the processing time for
many operations.

o TheCliptoolallows you to extract a portion of a raster dataset based on a template extent. The clip
output will include any pixels that intersect the template extent.

e The clipped area is specified either by a rectangular envelope using minimum and maximum x-
and y-coordinates or by using a output extent file. If the clip extent specified is not aligned with the
input raster dataset, this tool will make sure that the proper alignment is used. This may cause the
output to have a slightly different extent than specified in the tool.

e GotoRaster>Extraction > Clip Raster by Extent.

St W n n e e b | ke o ey

HH: % :-'E‘:' b % e (b i U ' "‘".'l 0 gt ! EE'- fie
E uy >
'tuf. J . b B el T i'-ﬁl 4
R . mrE
{GT18 :_
P nLg—
oy [ILEE

Vel b il it v ene ) ns L o g ke s il 4 Pam Semms @ &
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e Give clipping extent by selecting extent (through dragging to selected area) on canvas or use
layer/ canvas as extent as per the availability and run the process.

HH '.|-£"='r',r".|”,::-,++u-. ..T.'Eﬂ e & T $iz, L-
A Ae 2 B GRE i 4B 251 QA0 B +
B L]
1ET10
I gLl
| rom

b Liskafdide |

b W L

o

& ] g

o 75 [ e e .

e P v 081 83 st 0 P
' :Lu Comrg it fown. e, o, ]

i :::wwﬂ g vt o ik o b ]

= e i e e
" El i ¥ s e
r - ] 1 -‘mh‘“.
yE 2y
FRRT LT o T e P
2 e [T

e s b i Ty rie

| e Comieutn TR B G DA v NS bawadt 0 Hesw Spnos §

Subset/Clip of Raster Dataset

ko
e [ Sgpetion 30 e
G LR EERHE S (1R &I

] LN |

Final Output
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CHAPTER 9:

SUPERIMPOSED A SHAPEFILE
ON SATELLITE IMAGE

9.a (i) Opentherasterdataor satelliteimage.

9.a(ii) Openthe vector data (shapefile of point, line or polygon).

.~ Add vecter layer ? x
~Source type
® File Directory Database Protocal
Encoding | UTF-8 -
.Suume
Dataset . Browse
cuct ||t
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9.a(iii)) Addthe vectordata (i.e. shapefile of point,line and polygon) from add vector layer icon.

s Layers
ulick here to add vecto? V; “I « A :.' Y& ~3# "“%

' 7 @ Forest_Chowki .
. v B |
‘ Click here to add raster River |
,u @ = Road
7 o canal
[

B uttarakhand

9.b (i) Tochange weight (width) of point, line go to layers >select the point or line layer >right click on
it>goto properties option (alayer properties dialog will appear).
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9. b (ii) Select style >go to width option and change the width of point or line as the case may be.

Layers

'rﬂ" M. YE~ 3‘

i V| @ Forest_Chowki
F.Ithrer

* Road

“}m

¥ uttarakhand

Style

=]

&' Zoom to Layer

Show in averview
| & Remove
! Duplicate
Set Layer Scale Visibility
Set Layer CRS
Set Project CRS from Layer
Styles »
Open Attribute Table
4 Toggle Editing
Save As...
Save As Layer Definition File...
Filter...
Show Feature Count

Width

A\ Layer Properties - umiam | Style =
& Gegie Symbal | -
|‘ Siki Lt Pl -
Transpanency o[- wzth 22600
e T — x - e
Cokr | E—
------ SHITbE N group =)L
= W Line
[ w7 F
BN Savple ne
Braflews Canal  Censifl Construc Crossing Cydep  Dam
—— — - - —
Ditch Dren  Flobdwiy Footpath ety Leving & Locked|
I = —
Wotnrem Motorwm Pedasirie Primary  Primaey  Resajent Regier
ki k|| Y Seve
W Layer renderng
LS TAPERManTy (% .
Layer bl misds FarEal * Fashe bendng sede icarmal
Dearw effecs
Al e S— S | .1]'_
Sty [ e Coronl Aoy risp
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9.c (i) To change colour of the point, line and polygon go to layer >double click on the point polyline
or polygon shapefile> a layer properties dialog box will appear > click on style option >change
the colour of the shapefile.

Colour
Style
4 Layer Properties - polo | Style r S
e ey T snges x
Symb bayer bype Sanple fil
I
AOGaG0A)
i c ra] ) € o I
A il style | P
Borter ghyle | s—1Sgkd Line
¥ |: Fill z
Jonstie | glySevel
!, Bant pattern &
Berder width | 0, 260000 = =
. m ﬂ - -
Offsst ¥,y | 0000000 - 0000000 = |
@. = & Y | ¥ Baye Draw effects
* Layor remsdering
Lawer Iranspanency E
Layer biending mode Nu-rml = | Feature blsnding mode Harmal
Draw effects _|
1] €10
Siyle - oK Carcel Appy Help
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CHAPTER 10:

DIGITIZATION OF VECTOR FEATURE
[POINT, LINE AND POLYGON)
ON SATELLITE IMAGE

10.a Addasatelliteimagein QGIS layer.

10.b (i) To create a shapefile of point, line and polygon go to new shapefile layer menu > click in the
option new shapefile (refer Chapter 4 for creation of new shapefile).

7 \Jr; /7 New Spatialite Layer... Cirl+Shift+4
D | = G = = k
—INew Shapefie Layer h é » lew Shapefile Layer... Cirl+Shift-+N

|I£F*’?I Y I_EE W New Temporary Scratch Layer...
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10. b (ii) Start digitise the point feature, line feature and polygon with reference to the satellite image
(villages or locality as point features, river and road network as line features, open forest as
polygon).

10. b (iii) Afterdigitisingall the features >save and stop the layer.
10.c(i) Toname the features > select any features (either point, line or polygon) > right click on it >
select properties.
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10.c (ii) Layer properties table willappear > select Labels > select the option Label this layer.

Layers

|'|_7'“‘rm'-7 ‘u';‘”
| [V # Forest_Chowki

| 7 [l river

[}. - Road it Zoom to Layer
' Show in overview
['JI ' U‘l‘l‘irlldllnd ! Duplicate
| Set Layer Scale Visibility

T | ey crs

Set Project CRS from Layer
Styles b
'S Open Attribute Table
4 Toggle Editing
Save As..,
Save As Layer Definition File...
Filter...
Show Feature Count

Label
# Layer Properties - mver | b oy
Lk this Layer s = o
¥ TeutiAsfer sample
Lowerm Iouamm E
“#le Lahes |
b Tagh
2" Pormatting - = [*
7 & [
W macground Einke Nl = 4=
o Tk — = ] = E
5% Flacemant il & e | & Flele
4 —
e 2500 =
Povis - =
e and Lo - =
colour = =
Tearepawency 1) -k e =
Fape cmae MO Charis - 1_'
Spanng letter 00000 =k =S8
word | 2,000 il = H
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10.c (iii) Select the name of features > adjust colour of text, size and font format from the table > click
apply then ok.
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CHAPTER 11:

MAP COMPOSITION
IN QGIS

1.(@) To compose a map in QGIS >go to menu toolbar > click project> select new Print

Composer.
Project W\ 7 QGIS 2.10.1-Pisa
L [Project | Edit View Layer Settings Pl
| New Ctri+N
" Open... Ctri+0
New From Template '
Open Recent "
H save cir4s
B save as... Cirl+5hift+5 -
£}y Save asImage.., New Print Composer
DXF Export...

| Project Properties., /CH% —

- Mew Print Composer Ctri+p
+ Composer Manager...

Print Composers b
[0) ExitQels cri+Q

11.(b) After clicking on the new print composer one dialog box will appear >compose title > name
the composer title.

/' Composertitle 7 x
Create unique print composer title
(Gtle generated if left empty)
|Recnrded_|=nrest | ¥

[ ][ conce

11.(c) Opening the Print Composer provides you with a blank canvas that represents the paper
surface when using the print option> click on add new map>drag it in the map canvas.

[Fl=
a.ﬁ.dd NEW maph
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11.(d) Gotolayout toolbar to add label, scale bar, legend and north arrow >to generate or add grid >
click on item properties on the left side of map canvas > click on grid > add grid (+) > specify
the CRS >adjust the interval > select the draw coordinates option > change the format into
degree decimal or degree minute second.

Layout | Atlas Settings . North Arrow
1 Add Map
1w
- A4 L] Scalebar s | oty \ . o -
== Add Scalebar = : ¥
g dd d Lceend FRCHC e /
g Add Legen Arrow L e v Gots =
Add Image -+ - i v
=% Add Shape r RN Tesina. ] - i
7 add Arrow o \\ e
W Flaas gt
S| Add Atiribute Table oz e -
W2l Add HTML st | IR
—, o S W - Toam - i 1t Frima g GV LEGRE By
| Mowve
= i . A | = e
[Fg Move Content C g i - .
S w Scarth dreciones i
J-_Q Group Ctrl+G :;”Q:_IEHB“E{I T E '.11' T LR o=t 2
177 Ungroup Ctrl+5hift+3 SLQ— fﬂ TAA | A Ll nc] :
= - ]I {.-DI?*J ¥ T ! ; § L POCERRNN £
1. Raise Cirl+] @ AGC, O B 5y 4| | . 4
= - . ':;_ L \ 0 &
= R Ctri+[ J|. 1.4 ¥ 1 T : R
-*—*— el :
7 Bri i by =1 ; -
= Bring to Front Ctrl+5hift+] m L!E?-'ﬂ ST ® ﬁ" 2 # W Drww oondins
Send to Back Ctrl+5hift+[ e e wta | A el mL
E CPHENERS RIS L 18 s 4 = i Lef T ] !
= Lok Selected Ttems Cirl+L e P i
i 3 Do 2 I
) Unlock All Ctrl+5hift+L SR P = Fremt = =1
L — - el W

Composed Map of Goa

Recorded Forest Boundary of Goa
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CHAPTER 12:

CREATION OF BUFFER

12.a (i) Open QGIS software > add vector data or shapefile of point, polyline and polygon.

T T T T T T
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12.a(ii) Gotovector menuclick onit>goto Geoprocessing tools > select buffer.

Coortirete Caphure '
Dnef2shp ’
[F= L]
DpenSiresddan o
Road oraph b
Spabal Query x
Topolegy Chacker .

[}

3

b

WY tocls
| Anstyes Toos
o Roesearch Todls

Vechw | Raster Database MMOQGIS  Procsssing  Help

RBP L& HH

W Comve Hulllal_

' Eliminate Shver Polygonz...

If Buffer option is not available in
Geoprocessing tools then add
mmgqgis plugin to add.

;# G=ometry Took k ™ Buftesis).. # Pusgen | d 5TE l 7 =
;= Dats Management Tools  * Lo | 2 .‘u Seorih [ermcpal a]
. E L =
@ Union.. mmaqgis
ﬂ Symetrcal Difference.. Acﬂu_:l.im al QGIS werlor ayer
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b Differsnce.. margiatiog vector map layers o Quanhim S
11U s e sbess sk b i !
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el phages Agrmiad pgr
o ]

12.a (iii) After clicking on buffer option one dialog box will appear > specify or select the input vector
layer > next specify the buffer distance (in[ km ]) > then go to browse option > select a folder
to save the output file > click ok (the software will automatically process and calculate the

Buffer distance, T
5km

buffer).
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GLOSSARY AND ABBREVIATION

Geographic Information Systems (GIS)

GIS is a computer-based tool that analyzes, stores,
manipulates and visualizes geographic information on a
map.

Open Source Software (OSS)

0SS is a computer software with its source code made
available with a license in which the copyright holder
provides the rights to study, change and distribute the
software for any purpose. Open source software is
developed in a collaborative public manner.

Open Source Geospatial Foundation (OSGeo)

It is a non-profit and non-governmental organization
whose missionis to support and promote the collaborative
development of open geospatial technologies, data,
education and training. QGIS, GRASS, PostGIS, GDAL and
GeoServer are projects of 0SGeo (0sgeo.0rg).

General Public License (GPL)

GPL is a free and widely used software license standard,
which guarantees end users the freedom to run, study,
share and modify the software. The license was originally
written by the Free Software Foundation (FSF) for the
GNU Project and grants the recipients of a computer
program the rights of the Free Software Definition. The
GPL is a copy left license, which means that derivative
work canonly be distributed under the same license terms.

Raster

Raster data in GIS are matrices of discrete cells that
represent features of the earth's surface. Usually satellite
or areal imagery is represented in Raster data format like
GeoTIFF, img, pix, hdf (Hierarchical Data Format) etc.

Vector

Vector data is a coordinate-based data structure
commonly used to represent point, linear and enclosed
map features. Each linear feature is represented as X, y
coordinates. Attributes stored in a database are associated
with the features. Vector dataincludes:

1. Point features (Temple, Monuments, Forest Chowkies,
Forest Fire Point, etc.)

2. Line features (Roads, Railways, Fences, Cart-tracks,
Pack-Tracks, etc.)

3. Polygon features (Land Parcels, wetlands, forests,
etc.)
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Ground control points (GCPs

Control points are precise points with specific lat/long
coordinates to add manually so the georeferencing tool
canaccurately generate georeferenced layer.

Coordinate reference system (CRS)

A CRS is a system corresponding to a certain projection
and algorithm. Some of them are based on a latitude /
longitude base while others may respond to different
algorithms. Usually, each geographic entity has one or
several CRS which represents its best. The most common
CRS used for global projections is WGS 84.

Buffer

The buffer tool is a proximity function that creates a
polygon at a set distance surrounding a selected feature or
features.

Clip

Aclipisan overlay tool that involves clipping an input layer

with the extent of a defined feature boundary. The result of
this toolis a new clipped output layer.

Coordinates
Coordinates are sets of values representing one particular
geographical point. They are usually composed of two (x,

y) or three (X, y, z) dimensions, x representing a horizontal
value, y a vertical one, and z elevation.

Attribute table

An attribute table stores non-spatial information in
columns and rows about geographic data.

Feature

A feature is a cartographic point, line or polygon object
with a spatial location in the real-world landscape that can
be usedinaGIS for storage, visualization and analysis.

Latitude

The latitude is a vertical coordinate, ranging from 0° (at the
Equator) to 90° (North Pole) or -90° (South Pole). It
correspondsto they field in coordinates.

Longitude

The longitude is a horizontal coordinate ranging from 0° at
the Greenwich Meridian to 180° (East) and -180° (West). It
corresponds to the x field in coordinates.




Note: The latest release of QGIS is always available web page
https:/www.qgis.org/en/site/forusers/download.html

For further queries can connect m.bist83@gmail.com
Website: http:/www.fsi.nic.in



g -.
tThe cuttingofia'greenitree,is an offence punishahle in hell "
Padma Puran (56.40-41)

101826

9“?88194

Printed at Allied Printers, Dehradun






